MS Word-I
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard tips</td>
<td>1</td>
</tr>
<tr>
<td>Open Word/Start screen</td>
<td>2</td>
</tr>
<tr>
<td>File/Menu options</td>
<td>2</td>
</tr>
<tr>
<td>File/Open</td>
<td>2-3</td>
</tr>
<tr>
<td>File/Save as</td>
<td>3-4</td>
</tr>
<tr>
<td>File/Print</td>
<td>4-5</td>
</tr>
<tr>
<td>Pick up where you left off</td>
<td>5</td>
</tr>
<tr>
<td>To add a hint of color to the Ribbons/tabs</td>
<td>5</td>
</tr>
<tr>
<td>Blank document</td>
<td>5</td>
</tr>
<tr>
<td>Quick Access Toolbar (QAT)</td>
<td>6</td>
</tr>
<tr>
<td>Title bar</td>
<td>6</td>
</tr>
<tr>
<td>To exit Word</td>
<td>6</td>
</tr>
<tr>
<td>The Minibar</td>
<td>6</td>
</tr>
<tr>
<td>Super Tooltips</td>
<td>7</td>
</tr>
<tr>
<td>Status bar</td>
<td>7</td>
</tr>
<tr>
<td>Proofing</td>
<td>7</td>
</tr>
<tr>
<td><strong>Home Tab</strong></td>
<td>7-12</td>
</tr>
<tr>
<td>Clipboard group/Cut, Copy, Paste</td>
<td>8</td>
</tr>
<tr>
<td>Moving a block</td>
<td>9</td>
</tr>
<tr>
<td>Moving through a sentence</td>
<td>9</td>
</tr>
<tr>
<td>Format Painter</td>
<td>9</td>
</tr>
<tr>
<td>Font group</td>
<td>9-10</td>
</tr>
<tr>
<td>Highlighter</td>
<td>10</td>
</tr>
<tr>
<td>Paragraph group</td>
<td>10</td>
</tr>
<tr>
<td>Bullets/Numbering</td>
<td>10</td>
</tr>
<tr>
<td>Multi-level list</td>
<td>10</td>
</tr>
<tr>
<td>Decrease/Increase indent</td>
<td>10</td>
</tr>
<tr>
<td>Sort</td>
<td>10</td>
</tr>
<tr>
<td>Show/Hide Paragraph</td>
<td>11</td>
</tr>
<tr>
<td>Alignment</td>
<td>11</td>
</tr>
<tr>
<td>Line spacing</td>
<td>11</td>
</tr>
<tr>
<td>Changing line spacing default</td>
<td>11</td>
</tr>
<tr>
<td>Shading</td>
<td>11</td>
</tr>
<tr>
<td>Borders</td>
<td>11</td>
</tr>
<tr>
<td>Styles group</td>
<td>12</td>
</tr>
<tr>
<td>Editing</td>
<td>12</td>
</tr>
</tbody>
</table>
Insert Tab ................................................................. 12-14
   Illustrations group .................................................. 12-13
   Header & Footer group ............................................... 14
   Text group ................................................................ 14
   Symbols group .......................................................... 14
Design tab ................................................................. 14
Page Layout Tab ......................................................... 15-16
   Page Setup group (Margins) ........................................... 15
   Orientation (Portrait/Landscape) ................................. 15
      Columns .................................................................. 15
      Breaks .................................................................... 15
      Line numbers .......................................................... 15
   Paragraph group (Indent/Line spacing) ....................... 16
      Arrange group (Position/order objects) ...................... 16
References Tab (Endnotes/Footnotes) .......................... 16
Mailings Tab ............................................................... 16
Review Tab (Spelling/Grammar) ................................. 16-17
View Tab (Show/Hide/Rulers) ..................................... 17
Format Tab ................................................................. 19
   Move an image .......................................................... 19
   Shortcut keys ................................................................ 20-22
   Business letter format ................................................ 23
   Typing a letter ........................................................... 24-25
   Print a single envelope .............................................. 25
   MS Word business letter template .............................. 26
   Prepare yourself .......................................................... 26
   Keyboard keys ........................................................... 27
   Find and Replace ........................................................ 27
   Select all ................................................................... 27
   Double-space a document .......................................... 27
   Change the default font style and size ....................... 27
   Word Count ............................................................... 28
   Thesaurus shortcut ...................................................... 28
   Using the Format Painter button ................................. 28
   Changing Indentations ................................................. 28
   Page breaks ............................................................... 28
   Centering from top to bottom .................................... 28
   Delete unwanted files ................................................. 29
   Setting margins .......................................................... 29
   Open a non-MS Word document .............................. 29
Keyboard tips

This is a standard alphanumeric keyboard.

When typing a document in a word-processing program, you don’t need to press Enter at the end of a sentence; the word-processing program will do it for you automatically! To add a space between words, press the Spacebar.

To capitalize a letter, hold down the Shift key while pressing the specific letter.

If you want to end a paragraph, press Enter once or twice.

If you make a mistake when typing, pressing the Backspace key will remove a character to the left of the flashing cursor. The Delete key will remove a character to right of the flashing cursor.

You can use the Up, Down, Left, and Right arrow keys to move through a MS Office program, like Word or through an Internet page.

The Ctrl (Control) and Alt keys are on the lower left of the keyboard. You may use them to log on to your computer, or for shortcuts.
Open Word
Double-click on the Word 2013 icon on your computer’s Desktop or click on Start, All Programs, Microsoft Office 2013, and Word 2013.

To create a MS Word icon shortcut on your Desktop, go through the steps above and on the last step, Word 2103, right-click on it and drag it onto your computer’s Desktop and drop it when you want the icon to be. To open Word 2013, double-click on the icon.

Start screen

To begin, double-click on Blank document. You can also use one of the template designs that are shown or click on a Recent document you've worked on.

FILE is BACK! The round Office button is gone. To get to options like Open, Save, Save as, Print, etc., click on File in the upper left corner.
File menu options

This looks a bit different, but on the left are all the familiar choices. You can also see details about the document you’re working on.

Note: There’s a Back arrow to get back to your document.

File/Open recent

Open recently saved files by clicking on the file on the right or navigate to a file.
You can also click on Open, Computer, and on a specific location like the Desktop, or on Browse to choose another location, like a flash drive (insert the flash drive first) or folder.

File/Save as
Computer is the default location and from there, you can save to your Desktop, a selected folder, or click on Browse to choose another location, like a flash drive (insert the flash drive first).

1. Click on File and then on Save As or use the Ctrl+S shortcut. There is also a Save icon on the QAT.
2. The Save As dialog box appears. Click on the appropriate location, such as the flash drive, Desktop, etc. You will see a file name listed in the File name window. If you want the file to be called something else, you can type something else in the File name window. Then click on Save.
File names can be up to 255 characters long and can include numbers, but can’t include the following characters: * : \ ? “ < >

**Note:** You may need to save a document in an older MS Word format for those who don’t have Office 2013. Click on File, Save As, and then click on Word 97-2003 document.

You can also save a Word document as a Rich Text file, if you’re going to share the file with someone else and you’re not sure if they have MS Word. People sending resumes may need to save their resume as a text file, if the company is requesting a file in ASCII text.

**Status bar views:** Read mode (shows a multi-page spread), Print Layout (default view), and Web Layout. Zoom slider to decrease or increase the screen size for viewing.

**File/Print**
You’ll see print options and a preview of your document on the same page.

- To choose a specific printer, click on the down arrow under Printer.
- To print specific pages or a selection, click on the down arrow next to Print all pages under Settings.
To change the page layout from Portrait to Landscape, click on the down arrow next to Portrait Orientation under Settings.

To change the paper size, click on the down arrow next to 8 1/2x11.

At the bottom under the preview, you can see the number of pages in your document.

**Pick up where you left off**
When you open a previously saved document, you’ll see a pop-up on the right that you can click on to get back to where you left off.

**To add a hint of color to the ribbons** (if you do this in Word, it will add it to all Office programs automatically)
1. Open a blank or an existing document.
2. Click on your name in the upper right corner and on Account Settings.
3. Click on the down arrow under Office Theme and choose Light or Dark Gray.
4. Click on the Back arrow to get back to your document.

**Blank document**
Quick Access Toolbar (QAT)

To the far left is the Quick Access Toolbar with the Save, Undo and Redo buttons. To customize this toolbar, click on the down arrow and select the appropriate options, such as Print Preview and Print. You can click on More Commands and add a whole raft of options.

Undo and Redo
The Undo (Ctrl+Z) and Redo (Ctrl+Y) buttons are helpful. They look like curved arrows. These buttons are lifesavers when you make a mistake or when text disappears or you make a change and then change your mind.

Title bar
The top blue bar is the Title bar and it tells you that you’re using Microsoft Word and shows you the name of the document you’re working on. If you haven’t saved it yet, it will use the default title of Document 1. At the end of that bar are the:
- Minimize Window button, which looks like a minus or underscore sign
- the Restore button, which looks like two overlapping document windows
- and the Close button, which looks like an X. If you don’t want to exit the program, but want to switch to another program, like Excel or PowerPoint, you can click on the Minimize button and it will drop the program onto the Start toolbar, where you can click on it to bring it back up.

To Exit Word
To exit Word, click on the X in the upper right corner. If you haven’t saved your work, it will ask you if you want to save it before closing, in case you forgot to save it.

The MiniBar
This is really handy! When you want to add formatting to text, click and drag to select it and the MiniBar will appear. Click on the option of your choice. When you move the mouse again, the MiniBar will disappear!
**Super Tooltips**

The tooltips have expanded to give you more information. Hover the mouse over an option and a tooltip will appear.

---

**Status bar**

At the bottom of the screen is the Status bar. It will show the number of pages in your document, the number of words, proofing errors, the various page layouts (Print Layout is the default), and the Zoom level (increase or decrease by sliding the zoom marker).

---

**Proofing**

If you see underlined text in your document, click on the Proofing Errors button and a pop up on the right will appear offering correction options. Below, Duck was spelled incorrectly, so spelling options appeared.

Click on the X to close the Proofing Errors window when finished.

---

**Home Tab (Ribbon)**

Change the font style, size, color, alignment, and more. Click on the group launcher arrow for more options.
Groups
At the bottom of the tab are heading names called Groups. Each Menu option has its own Groups. The Home groups are Clipboard, Font, Paragraph, Styles, and Editing. Click on the launcher down arrow next to the group name for more options.

Clipboard Group

<table>
<thead>
<tr>
<th>Cut</th>
<th>Copy</th>
<th>Format Painter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Format Painter</td>
<td>Paste is the large icon</td>
</tr>
</tbody>
</table>

If you’ve copied multiple images, click on Clipboard to select one.

Cut, Copy, Paste
You’ll notice that the scissors or Cut icon, and the two pieces of paper or Copy icon aren’t available.

Whenever a button is faded out, it means it’s not functional, because there’s nothing for it to work on.

In order to cut or copy something, you have to have something selected. You select what you want to cut or copy by:

1. highlighting it, which means clicking and dragging over it with the mouse
2. single-clicking in the space to the left of a sentence will select it. Double-clicking in the space to the left of a sentence will select the entire paragraph.
3. double or triple-clicking on it with the left mouse button will also select it
4. clicking before the first letter of the paragraph or section you want to select, and then holding down the Shift key and clicking after the last letter in the paragraph or section.
5. pressing Ctrl+A to select all the text

Cut and Copy are similar, but using the Copy function keeps the text visible, whereas Cut removes it.

The Paste button looks like a clipboard with a piece of paper in front of it. If you cut something and want to paste it into another document or paste a copy of a picture into a document, you need to use the Paste function.

Instead of retyping something, that you can to repeat again and again, it’s easier to copy and paste it.
Moving a Block
To move a block of text
   1. by highlighting it,
   2. and then clicking on it and dragging it where you want it to go.

Moving through a sentence
   1. Move from word to word – Ctrl+arrow keys
   2. Go to beginning of sentence - Home
   3. Go to end of sentence - End

Format Painter
The Format Painter button looks like a paintbrush and allows you to copy a format, like Bold, Italic, or Underline, and duplicate it throughout your document.
   Say you want to have a lot of words or sentences of your document in Bold type.
   1. Click and highlight the first word or sentence you want to change
   2. Click on the Bold button.
   3. Double-click on the Format Painter icon button
   4. Place the I-beam cursor on the first letter of the word or sentence you also want bolded. You can see the I-beam pointer now has a paint brush next to it.
   5. Click and drag across it to change it. Click on the Format Painter again to turn it off.

Font group
The standard font options, like font type, font size, Bold, Italic, Underline formatting, and font color are here. Some additions are Strikethrough, subscript, superscript, change case (make all letters uppercase or lowercase), Grow font, Shrink font, Highlight, and Clear All Formatting. Click on the launcher for more options.

The Word default settings are generally Normal Style or Body Text Indent Style, Calibri and 11 pt. If you want to change it to another font style/size, on the Home tab, click on the Font group launcher, choose another font style/size and click on the Default button.
   Click on Yes to add this to the Normal template and on OK.
To change the font color, click and drag to select the text and click on the down arrow next to the Font color icon (looks like an A over a line) to select a new color.

**Text Effects and Typography**
This is a shortcut to add shadows, outline glow, etc. to selected text.

**Highlighter**
You can select text and then click on the Highlighter button. It will add yellow or the color of your choice behind the selected text. This is handy for when you are working on a document and have a word or section you might need to change at a later date. When you scroll through the document, the highlighted text will be more noticeable.

**Paragraph group**
These options were prominent in the old version: Bullets, Numbering, Decrease Indent, Increase Indent, Sort, Show/Hide, Left Align, Center, Right Align, Justify, and Borders. Additions are the Multilevel List, Line Spacing, and Shading options. Click on the launcher for more options.

**Bullets/Numbering**
The Bullets button adds a series of bullets to a list. The Numbering button adds a series of numbers to a list.

**Multi-level list**
Create an outline look to your document.

**Decrease Indent/Increase Indent**
Use these options to decrease or increase the paragraph indentation (whole paragraph moves), to the Outside border button. Click on the down arrow next to that button and you'll see buttons that you can click on to place a border in your document. This is a function we'll use later.

**Sort**
Alphabetize or sort information numerically.
Show/Hide Paragraph button
Click on the Show/Hide paragraph icon button.
It shows the little paragraph markers and puts dots between all your words.
If you like that style, turn it on by clicking on it. Or if it’s on and you want to get rid of it, click on it to toggle it off.

Alignment buttons
Here’s where the text alignment buttons reside.
The default setting for Word is Align left. You can change that as necessary when working on a document. I use the Align left or Center buttons the most.

Line Spacing
You can change a document from single-spaced to double-spaced with a few clicks. You can click and drag over the entire document to highlight it, then click on the Home tab and in the Paragraph group, click on the down arrow next to Line Spacing and click on 2.0. An easier way to double-space a document is the Speed Demon shortcut key method of Ctrl and the letter A to Select All or the entire contents of a document, and then hold down the Ctrl key and press the number 2 and let go of both keys.
If you only want a certain paragraph to have specific spacing, click within that paragraph and then click on the down arrow next to Line Spacing and choose the appropriate option.

Changing Line Spacing default
To change the default of 1.5 spacing between lines, click on the down arrow next to Line Spacing and click on Line Spacing Options/Spacing/Line Spacing and click on Single. Then click on the default button.
You may also need to delete the spacing after a paragraph. Click on the Line Spacing icon and on Line Spacing Options. In the Spacing Options section, make sure that it says 0 pt. in the After window. Click on Default to make this change permanent or on OK for this document.

Shading
To add color behind your text, click on the Shading button and then on the color of your choice.

Borders
To add a border around a block of text, click on the down arrow next to Borders and click on the style of your choice. You add change the style of the border or the width of the line.
**Styles group**
There are some styles for you to choose from and more may be available depending on your monitor settings. You can move the mouse pointer over each heading and see how it would change, if you wanted a different look. There’s a down arrow for more choices. For more options, click on the launcher.

![Styles](image)

**Editing**
Need to search for text in a long document? Need to make a change to text throughout a document? The Find, Replace, and Select options are readily available. Select helps find objects that may be hidden by text.

**Insert Tab**
Insert pictures, clip art, files, tables, headers/footers, page numbers, text boxes, Word Art, and more. To insert a file – Insert, Object, and then click on the down arrow to choose Text from File.

To close the **Header/Footer option**, click on the Close button on the toolbar.

**Illustrations group**
You can insert a variety of images (both from a file and Online Pictures (formerly ClipArt), Shapes, SmartArt, Charts, and even Screenshots.

Click on the Shapes button to see the variety of shapes from which to choose.

While you’re in AutoShapes, move the pointer to Basic Shapes and click on the Smiley face.

1. You’ll see a cross appear on your screen.
2. Click and drag anywhere on the white space to make the Smiley face appear.
3. You can make it about two-inches or so.
4. Look at the rulers on the top and side to determine the size.
5. You'll notice a yellow sizing handle in the shape of a diamond.
6. This handle lets you move the line, in this case it will go up or down.
7. Make Mr. Smiley frown, by placing the mouse pointer, which becomes an arrowhead, on the yellow diamond and click to drag it up.
8. You can make Mr. Smiley happy, sad or indifferent.

To see how the sizing handles affect a shape, click on a middle-sizing handle of Mr. Smiley and drag it out about ¼ inch. Now click on the Undo button on the Standard toolbar to put him back the way he was.

Whenever you’re working with a shape or picture, it’s important to drag the corner sizing handles if you don’t want to distort a shape.

Try clicking and dragging one of the corner-sizing handles about ¼-inch. It made Mr. S larger, but didn’t distort him.

Click on the green Free Rotate handle and drag to rotate the shape.

To add some color to his face, click on the Fill Color button, which looks like a tipped paint can.

The shape should be filled with yellow or whatever color is under the paint can. You can change the color, by clicking on the down arrow next to Fill Color and choosing another color.

To change the color of the lines that makes up the circle of the face and the features, click on the Line Color icon, which looks like a pencil. The line will become blue or whatever color is under the pencil.

You can change it:
1. by clicking on the down arrow next to the Line color icon and choosing another color
2. or you can get rid of the line by clicking on the down arrow and clicking on the No Outline choice.

You can get rid of a shape or text box:
1. by clicking on the shape or the shaded area of a text box and then clicking on the Cut icon or press the Delete key
2. or by right-clicking on the shaded area of a shape or text box and then clicking on Cut.

When you work with shapes, you can flip them:
1. by clicking on the
2. and clicking on Rotate or Flip - flip horizontal.

This is handy when you are using shapes or arrows and need to change their direction.
Header & Footer group
Add a Header/Footer or insert page numbers.
To close the Header/Footer option, click on the Close button on the toolbar.
To edit a header/footer, right-click on the text and on Edit footer.

Text group
There are times when it’s best to insert a Text Box while working in a document.
Doing so let’s you precisely place text where you want it. The default is to have a line
around it, but we’ll learn how to remove the line.

Click on the Text box icon button. You’ll have some preformatted options, but for
right now, click on Draw Text Box and then click and drag to make a text box on the
screen. You’ll get a cross, just like you saw for Mr. Smiley.

Note that the box, like any shape, has blue squares in the middle and corners.
You can adjust the size of the text box by clicking and dragging on the sizing
handles.

Click on the text box, and when you move the pointer to the edge, you will see
the 4-headed arrow which will allow you to move it around on the screen.

The WordArt button looks like a blue tipped letter A. It allows you to insert a
headline from a group of choices, but still allows you to make more formatting
changes.

Symbols group
To insert a symbol, like a foreign character, click on the Symbol button and if you don’t
see the symbol button you want to use, click on the More Symbols options. Each font
style has its own symbols, so you will have lots to view! Webdings and Wingdings have
the best image symbols.

Design Tab
There are a variety of themes that can instantly alter the formatting of your document. Type
the text and then rest the mouse pointer on the various options. You may not notice much of
a change. You can also choose the default Colors, Fonts, Paragraph Spacing, add a
Border, etc.
Page Layout Tab
Change the margin settings, layout orientation, insert columns, add a page break, change the paragraph spacing, and change the way images/text boxes are placed on the page.

Page Setup group
Margins
You can change the margin dimensions by Clicking on the Page Layout tab and clicking on Margins. You can choose a default option or click on the Custom Margins link at the bottom and type in your own coordinates. This is really handy when trying to fit information on a page or when using preprinted paper that has a heading or design on it. The Office 2013 default settings are:

- Top: 1-inch
- Bottom: 1-inch
- Left: 1-inch
- Right: 1-inch

Orientation
To change the page view to Landscape, click on the Orientation button and then on landscape.

Columns
To divide a page into columns, click on the Columns button and click on the appropriate choice. Note there is a More Columns option at the bottom.

Clicking on two will divide the page into two columns. It will look like two justified columns.

Columns are important when creating a newsletter, which I’ll teach in the Word-II. This feature is also useful when you have to make long, narrow lists of things.

Breaks
Need to add a page break? Click on Breaks and click on the appropriate option.

Line Numbers
Place a number before each sentence on a page, to keep track of the number of lines.
Paragraph group

**Indent**
To indent a paragraph, click on the up/down arrows to choose the indent amount of your choice. The default is 0.5" on Left.

**Spacing**
To change the line spacing between paragraphs, click on the up/down arrows to make the appropriate choice.

**Arrange group**
To change the position/order of an object, like an image or text box, click on the object and then on the appropriate option.

References Tab
Click on References to add Endnotes or Footnotes, a Bibliography, update tables, mark entries, and more.

Mailings Tab
Print envelopes and labels, work with Mail Merge, and more.

Review Tab
Check spelling & grammar, do simple translations, use the Thesaurus, track changes, protect sheet, and more.

Proofing group

**Spelling and Grammar**
The ABC with the check mark is the Spelling and Grammar icon button, which allows you to Spell check an individual word or a paragraph or an entire document. It will check the grammar, too.
A red wavy line means the dictionary doesn’t recognize the word.  
A green wavy line means the grammar checker.  
A blue wavy line means there’s inconsistent formatting.  

To correct a word or sentence that has a wavy line under it, right-click on it with the right mouse button.  

It will bring up a menu that will give you some choices, if there are any.  
For spelling, you can select the correct word by clicking on it or you can add the word to the dictionary by clicking on the Add choice.  
By right-clicking on the green wavy line, it will bring up the grammar checker and choice of correct sentences to choose from. Be forewarned that the grammar checker isn’t always correct. It’s been culled from a business standpoint and sometimes has problems with common sentence structure and possession.  

Note the Thesaurus option.

View Tab  
Print layout, adding the ruler, and more.

Show/Hide  
Rulers  
Around the document screen, you can choose to view rulers on the left and top to show you the length and width of the page. To view the ruler, if it’s not visible, click on the View tab and then on Ruler.  
You have the option of using the black arrows to move up and down through your document or use the double arrows to page up and page down. You can use Page Up and Page Down keys or the Spin dial on the mouse.  
Zoom  
Another way to change the zoom or view multiple pages at once.  
Window  
To open a New Window, Split Windows, View Side by Side, etc. You can also switch between open Word documents by clicking on Switch Windows.
Format Tab
When you need to work with an image or shape, click on the Format tab that appears. You can adjust brightness, recolor, crop, compress images, add effects, change the order of an image on a page, and more.

Format view when working with an image or shape

Move an image
When an image has been inserted, move the mouse pointer to the right of the image, click on the Layout Options button, and on the appropriate alignment, such as Top and Bottom or Tight.

Move the mouse pointer to the top edge of the box to drag it into position, if necessary.
### Most popular shortcuts

1. **Ctrl+C** to copy text or graphics
2. **Ctrl+V** to paste text or graphics
3. **Ctrl+A** to select all the text in a document
4. **Home** to get to the beginning of a sentence
5. **End** to get to the end of a sentence
6. **Ctrl+Z** to Undo an action
7. **Ctrl+Y** to Redo or repeat an action
8. **Ctrl+Arrow** to move across, one word at a time
9. **Ctrl+Shift+<< or >>** Decrease or increase font size

<table>
<thead>
<tr>
<th>To:</th>
<th>Press:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the case of the letters</td>
<td>Shift+F3</td>
</tr>
<tr>
<td>Format all letters as capitals</td>
<td>Ctrl+Shift+A</td>
</tr>
<tr>
<td>Format all letters as small capitals</td>
<td>Ctrl+Shift+K</td>
</tr>
<tr>
<td>Apply subscript formatting</td>
<td>Ctrl+Equal Sign</td>
</tr>
<tr>
<td>Apply superscript formatting</td>
<td>Ctrl+Shift+Plus Sign</td>
</tr>
<tr>
<td>Apply bold formatting</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Apply italic formatting</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Apply an underline</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Underline the words, but not spaces</td>
<td>Ctrl+Shift+W</td>
</tr>
<tr>
<td>Double-underline text</td>
<td>Ctrl+Shift+D</td>
</tr>
<tr>
<td>Create a new document</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open a document</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Close a document</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Save a document</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Quit Word</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Find Text and formatting</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Replace text and formatting</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Go to a page or other location</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Cancel an action</td>
<td>ESC</td>
</tr>
<tr>
<td>Delete one character to the left</td>
<td>Backspace</td>
</tr>
<tr>
<td>Delete one word to the left</td>
<td>Ctrl+Backspace</td>
</tr>
</tbody>
</table>
Delete one character to the right Delete
Delete one word to the right Ctrl+Delete

When setting line spacing: Press:
Single-space Ctrl+1
Double-space Ctrl+2
Set 1.5-line Ctrl+5
Center a paragraph Ctrl+E

To Move: Press:
One character to the left Left Arrow
One character to the right Right arrow
One word to the left Ctrl+Left Arrow
One word to the right Ctrl+Right Arrow
One paragraph up Ctrl+Up Arrow
One paragraph down Ctrl+Down Arrow
Up one line Up Arrow
Down one line Down Arrow
To the end of a line End
To the beginning of a line Home
Up one screen Page Up
Down one screen Page Down
To the top of the next page Ctrl+Page Down
To the top of the previous page Ctrl+Page Up
To the end of a document Ctrl+End
To the beginning of a document Ctrl+Home

To insert: Press:
A line break Shift+Enter
A page break Ctrl+Enter
A column break Ctrl+Shift+Enter
The copyright symbol Alt+Ctrl+C
The registered trademark symbol Alt+Ctrl+T
Select text by holding down Shift and pressing the key that moves the insertion point.
<table>
<thead>
<tr>
<th>To select a selection</th>
<th>Press:</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character to the right</td>
<td>Shift+Right Arrow</td>
</tr>
<tr>
<td>One character to the left</td>
<td>Shift+Left Arrow</td>
</tr>
<tr>
<td>To the end of the word</td>
<td>Ctrl+Shift+Right Arrow</td>
</tr>
<tr>
<td>To the beginning of a word</td>
<td>Ctrl+Shift+Left Arrow</td>
</tr>
<tr>
<td>To the end of a line</td>
<td>Shift+End</td>
</tr>
<tr>
<td>To the beginning of a line</td>
<td>Shift+Home</td>
</tr>
<tr>
<td>One line down</td>
<td>Shift+Down Arrow</td>
</tr>
<tr>
<td>One line up</td>
<td>Shift+Up Arrow</td>
</tr>
<tr>
<td>To the end of a paragraph</td>
<td>Ctrl+Shift+Down Arrow</td>
</tr>
<tr>
<td>To the beginning of a paragraph</td>
<td>Ctrl+Shift+Up Arrow</td>
</tr>
<tr>
<td>One screen down</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>One screen up</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>To the end of a window</td>
<td>Alt+Ctrl+Page Down</td>
</tr>
</tbody>
</table>
Business letter format

1234 Elm Street
Florence, KY 41042

December 4, 20XX

Mr. Rob Kelland
Human Resource Manager
Best Job, Inc.
1234 Davidson Avenue
Florence, KY 41042

Dear Mr. Kelland:

I am writing to apply for the programmer position advertised in the Cincinnati Enquirer. I’m very interested to talk to you about Best Job’s progressive growth and how I can help reach your goals. As requested, I am enclosing a completed job application, my certification, my resume and three references.

The opportunity presented in this listing is very interesting, and I believe that my strong technical experience and education will make me a very competitive candidate for this position. The key strengths that I possess for success in this position include:

- I have successfully designed, developed, and supported live use applications
- I strive for continued excellence
- I provide exceptional contributions to customer service for all customers

With a BS degree in Computer Programming, I have a full understanding of the full life cycle of a software development project. I also have experience in learning and excelling at new technologies as needed.

Please see my resume for additional information on my experience. Thank you for your time and consideration. I look forward to speaking with you about this employment opportunity.

Sincerely,

Jason P. O’Dell
Typing a business letter

Open MS Word 2013 by double-clicking on the Word icon on the Desktop.

What is proper business letter format?
If you don’t have pre-printed letterhead, use 24-pound paper with 100% brightness. Standard copy paper is 20-pound and the whiteness varies. Margins should be 1-inch on all four sides. To make sure your margin settings are correct, click on the Page Layout tab, on Margins in the Page Setup group, and click on Normal. Use Times New Roman or Calibri font in size 12 in black.

Block format is standard, meaning all information is left-aligned, but you can center your address at the top, if you don’t have a letterhead.

Press Enter to move the cursor about 1.5 to 2-inches down from the top of the page.

You can type your return address in block format or center it. Type your return address (no abbreviations for Street, Avenue, etc.). Press Enter. Type your City, ST (the two-letter state abbreviation] Zip code. Press Enter twice.

Type today’s date and press Enter twice (December 4, 2010).

Type the recipient’s name and press Enter.
Type the recipient's job title and press Enter.
Type the business name and press Enter (no abbreviations for Street, Avenue, etc.).
Type the business street or P. O. box address and press Enter.
Type the business City, ST and Zip code and press Enter twice.
Type the greeting/salutation, Dear Mr. or Ms. XXXXXX followed by a colon.
Ex. Dear Mr. Ray Raymond:

Press Enter twice and type the first paragraph, single-spaced.
The first paragraph of a business letter is used to state the main point of the letter. If this is for a job opening, you can begin by stating where you heard about it; newspaper, website, friend, etc. Then, state the purpose of your letter. Add a sentence or two more to explain the purpose.

Beginning with the second paragraph, state the supporting details to justify your purpose. It could be why you are right for this position or key background information. If you need to add another paragraph with details, do so.

Use the closing paragraph to restate your purpose and why it is important. You can even add a reference for the potential employer to contact. Also, it’s nice to thank the recipient for considering you as a candidate and taking the time to read your letter.

Press Enter twice and type the closing, Sincerely, followed by a comma.
Ex. Sincerely,

Press Enter four times and type your name. Doing so leaves space for you to sign your name, preferably in black ink.

Use the Print Preview button to do a final check before printing. Correct any spelling errors and adjust the letter spacing – it should fit well on the page, without a big chunk of white space at the bottom.

*See the sample business letter to check your format.*

You can save a copy of your letter to a flash drive or CD.

When printed, fold the letter into even thirds and put it in a #10 white business envelope.

**Print a Single Envelope**
Click on Mailings tab, then on Letters and Mailings, and then on Envelopes in the Create Group. Type in the mailing address and the return address (you can check the omit box, if you don’t want one). Make sure an envelope is placed correctly in the printer – look on the drop-down tray for directions for your printer. Most printers will print on a Standard #10 business envelope. Click on Print.
MS Word Business Letter Template

You can use a MS Word template to create a business letter.
1. To do so, click on File in the upper left-hand corner.
2. Click on New and in the search window at the top, type cover letters and press Enter.
3. Click on one of the Cover letter options or scroll through and click on a specific cover letter.
4. Click on Download.
5. Click on the bolded text and type the requested information.
6. In the body of the letter, click and drag over the paragraphs to type the appropriate information. You can use some of the text that’s already there.
7. Click and drag to remove Enclosure, if you’re not attaching anything.
8. Click and drag over the McGraw-Hill text at the bottom and delete it.

Print, sign, and mail. Don’t forget an enclosure, such as your resume, if you said you’d include it.

Renaming a document
To change the name of a saved document, right-click on the name of the file and click on Rename. Type a new name and then click in the blank space to save it.

Interesting Tidbits

Prepare yourself
1. Avoid eyestrain by turning your monitor away from a sunny window
2. Make sure the top of your monitor is 2-3 inches above eye level and 16-30 inches from your eyes. Look away from the monitor at regular intervals and focus on something far away.
3. Adjust the Display settings on the monitor, if the icons are too small.
4. Adjust your chair, if possible, so the seat height is at a comfortable range for the length of your legs. You may want to use a back pillow for lumbar support.
5. Adjust the keyboard height, if possible. Try to keep your wrists and hands as level as possible. Take frequent typing breaks. Shake your hands or try bending your hands backwards (palms up, force fingers down at a right angle and palms face down, force fingers up at a right angle).
6. Make your office space pleasant with pictures, live plants, a few accessories, etc.
Keyboard keys
Esc – press this key to get rid of context boxes
Tab – moves cursor to the right ½-inch at a time
Backspace – removes one character to the left of the flashing cursor
Delete – removes one character to the right of the flashing cursor
Home – moves the cursor to the beginning of a line
End – moves the cursor to the end of a line
Enter – use to being a new paragraph (DON’T press Enter at the end of each sentence)

Find and Replace
If you want to find a word or change a word in a document, you can do it easily by pressing the Ctrl+F shortcut combination to find the word. To change the word, click on the Replace tab, type the current word in the first window and the word you wish to use instead, in the second window. Click on Replace or Replace All, if the word appears multiple times throughout the document.

Select All
To select an entire document to copy it, move it, or change the line spacing, press Ctrl+A.

Double-space a document
Select the document or area of the document you want to change the spacing on and press Ctrl+2 for double-spacing or click on the down arrow next to the Line Spacing button on the Home tab and click on 2.

Change the default setting for Font style and size
Standard default for Word 2013 is Calibri 11 pt.
If you want to change the font style and size, click on the Home tab, on the launcher arrow in the Font group, and on Font. Under Font, click on the Font Style of your choice and under Size, click on the size of your choice. Click on Default, Yes, and then on OK. All future documents will be changed.
Checking the Word Count
How many lines and words are on a page?
- On a standard page of single-spaced type, 12 pt. text, there are about 45 lines and 654 words
- On a standard page of double-spaced type, 12 pt. text, there are about 23 lines and 353 words
- To check the Word count of a document, look at the lower left-hand corner next to Words

Thesaurus Shortcut
Select the word you want to look up and press the shortcut combination of Shift+F7 to choose a new word.

Using the Format Painter button
To copy formatting that you want to use again and again in your document, make the first change, such as adding Bold formatting to a word. Click and drag over the word(s) and click on the Home tab. In the Clipboard group, double-click on the Format Painter brush. Then click and drag over all the other word or words you wish to bold or change the formatting on.

Changing Indentations
You can automatically indent the first sentence of a paragraph by clicking on the marker on the top ruler and moving it to the .5 dash on the ruler. Place the mouse pointer on the top marker and a screen tip that says First Line Indent will appear. Click on the very top marker and drag it to the ½ inch dash. To line up text evenly, highlight the rest of the paragraph and move the Hanging Indent marker accordingly. You can indent an entire paragraph by clicking and dragging to select it and then pressing the Tab key.

Page Breaks
To make a hard page break, use the Ctrl+Enter shortcut. To delete a page break, press Backspace or delete.

Centering a Page from Top to Bottom
Click on the Page Layout tab. Click on Margins in the Page Setup group. Click on Custom Margins at the bottom. Click on the Layout tab and click on the down arrow next to Vertical alignment under Page and click on Center. Click on OK.
Delete Unwanted Files
Open the place where the files are located. Right-click on the file you no longer need click on Delete. Click on Yes, if you’re sure you want it deleted.

Note: Files from storage mediums like a CD or flash drive will go into cyberspace when deleted, so make sure you really want to delete them.

Setting Margins
Click on the Page Layout tab and then on Margins in the Page Setup group. Choose one of the standard options or click on Custom Margins at the bottom.

Normal pages settings for an 8½x11-inch page are:
Top 1”  Bottom 1”  Left 1”  Right 1”
You can change these in order to fit more on a page or when using preprinted stationery.

Open a non-MS Word document
Click on File and Open or use the Ctrl+O shortcut.
Click on the appropriate drive or location to find the saved file.
If you don’t see any files listed, click on the down arrow next to Files of Type and click on the All Files choice. This should at least let you see the files. If you know the program used to create the file, see if it’s on the Files of Type list, select it from the list and open the file.

- Notice that you can open files that have been created with lots of programs, including versions of Works, WordPerfect, HTML, etc.

Help
Click on the question mark in the upper right-hand corner. Type in the keyword(s) you’re looking for and press Enter. Click on the appropriate result or try other keywords.

Helpful Websites
Need more help using MS Word 2013?
Try the link on our Webpage - www.bcpl.org
Click on Information Desk/Computer Classes and then on the MS Office Tutorials.

On the Computer Classes page, you will find mouse practice and typing tutorials, too.
Websites with letter examples:
Cover letters - http://jobsearch.about.com/od/coverlettersamples/a/coverlettsample.htm
Business letters (all kinds) - http://www.letterwritingguide.com/